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Design Integration Using Autodesk Revit 2010

Lesson 7
Law Office: ROOF, FLOORS & CEILINGS::

Now that you have the floor plans developed to a point where only minor
changes will occur, you can start thinking about the horizontal planes within
the building: roofs, floors and ceilings.

In this text you will start with the roof. This is the first element most often
modeled of the three elements covered in this chapter. It is first because,
with the roof in place, the exterior of the building begins to take its final
shape, specifically in 3D and camera views.

Floors and ceilings are then added so the building sections start to take
shape. These elements, plus a consultation with the mechanical engineer on
the approximate size of the ductwork, will help to determine the distance
required between the floors and the roof.

The depth of the structural system is also an important factor when
processing the horizontal conditions of your building. This will be covered in
the next chapter, but in reality would be considered parallel with the
information covered in this chapter via the structural engineer.

® 5 ° &

_/ | |

Building section showing floors, ceilings and the roof; notice structural and ductwork as well.
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Introduction to the Roof tool

In this lesson you will look at the various ways to use the Roof tool to draw
the more common roof forms used in architecture today.

0. Masanry

oo

i L
Exercise outcome: Hip, Gable, Shed and Flat roof designs
Start a new Revit Project:
You will start a new project for this lesson so you can quickly compare the
results of using the Roof tool.

1. Start a new project using the default.rte template.

2. Switch to the North elevation view and rename the level named
Level 2 to T.O. Masonry. This will be the reference point for your
roof. Click Yes to rename corresponding views automatically.

TIP: Jjust select the Level datum and
click on the level tag’s text to rename.
’ velfags et o n _ T.0. Masonry S

3. Switch to the Level 1 floor plan 10" - 0"
view.

Draw walls to setup for using the Roof tool:

4. Set the Level 1 Detail Level to medium

so the material hatching is visible within sl
the walls. U Coarse
TIP: Right-click on Level 1 in the Project B3 Fine

Browser and select Properties, or use the
View Control Bar at the bottom.

e =10" [0 2 H

5. Using the Wall tool and wall type set to Exterior - Brick on Mtl.
Stud, draw a 40'-0" x 20’-0" building (Figure 7-1.1).

FYI: The default Wall height is ok it should be 20"-0".



Law Office: ROOF, FLOORS & CEILINGS

Be sure to draw the 8
building within the
Elevation Tags.

TIP: You can draw the
building in one step if
you use the rectangle
option on the Ribbon,
while using the Wall
tool.

Elevations tags (4) are shown which
correspond to the four elevation
views listed in the Project Browser. \

(]

Figure 7-1.1 Building and Elevation tags

You will copy the building so that you have four in total. You will draw a
different type of roof on each one.

6. Drag a window around the walls to select them. Then use the Array
command to set up four buildings 35’-0" O.C. (Figure 7-1.2); see
ARRAY TIP below.

TIP: Zoom in and 0
make sure the brick
is on the exterior
side of the wall; if
not, you can select
each wall and click
its Flip icon.

ARRAY TIP: Select
the first building,
select Array, and
then, just like the
Copy command,
define a copy 35’ to
the right, and then
enter the number
of copies. You can
also refer to page A
5-53.

Figure 7-1.2 Four buildings

7. Select all of the buildings and click Ungroup from the Ribbon.
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Hip roof: [ Roof |-

The various roof forms are largely defined by the “Defines oof By Footprint
Slope” setting. This is displayed in the Options Bar while

the Roof tool is active. When a wall is selected, while the @, Roof By Extrusion
“Defines slope” option is selected, the roof above that

portion of wall slopes. You will see this more clearly in the @ Roof by Face

examples below.
8. Switch to the T.O. Masonry floor plan view. Q/
Fascia

9. Select Home > Build > Roof (down-arrow)
- Roof by Footprint tool.

10. Set the overhang to 2’-0"” and make sure Defines slope is selected,
by being checked in the Options Bar.

Create Roof Footprint Defines slope Cwerhang: 2' 0" [ Extend to wall core 1

11. Select the four walls of the building, one at a
time, at the far left.

TIP: Make sure you select towards the exterior side
of the wall; notice the review line before clicking.

12. Click Finish Roof on the Ribbon. o

13. Click Yes to attach the roof to the walls.

14. Switch to the South elevation (Figure 7-1.3).

- ___________________________________mme_
A oty

L 11,
—- -—- -—- -—- it

Figure 7-1.3 South elevation - Hip roof

You will notice that the default wall height is much higher than what we
ultimately want. However, when the roof is drawn at the correct elevation
and you attach the walls to the roof, the walls automatically adjust to stop
under the roof element. Additionally, if the roof is raised or lowered later, the
walls will follow; you can try this in the South elevation view by simply using
the Move tool. REMEMBER: You can make revisions in any view.
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15.

Switch to the 3D view using the icon on the View toolbar (Figure 7-

1.4).

You can change the Model
Graphics Style to Shading
with Edges if you'd like.
Select the Model Graphics
Style icon on the View
Control Bar at the bottom.

s

Figure 7-1.4 3D view - Hip roof

Gable roof:
16. Switch back to the T.O. Masonry view.
17. Select the Roof tool, and then Roof by Footprint.
18. Set the overhang to 2'-0” and make sure Defines slope is selected

(checked) in the Options Bar.

19. Only select the two 40’-0” long walls.
20. Uncheck the Defines slope option.
21. Select the remaining two walls (Figure 7-1.5). K
22. Pick Finish Roof on the Ribbon (see image to right). FF'{:;? C;;éfel
23. Select Yes to attach the walls to the roof. Roof
24. Switch to the South elevation view (Figure 7-1.6).
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I

Figure 7-1.5 Gable - plan view

T.0. Masonry_
ey

Level 1
o %

Figure 7-1.6 South elevation - gable roof

25. Switch to the 3D view (Figure 7-1.7).

Notice the wall extends up to conform to the underside of the roof on the
gable ends.

FYI:

You may be wondering why the roofs look odd in the floor plan view. If you
remember, each view has its own cut plane. The cut plane happens to be lower
than the highest part of the roof. Thus, the roof is shown cut at the cut plane. If
you go to View Properties 2 View Range and then adjust the cut plane to be
higher than the highest point of the roof, you will then see the ridge line.

7-6
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>

Figure 7-1.7 3D view - Gable roof

Shed roof:

26. Switch back to the &7 Instance Properties =)
T.0. Masonry view.

Family: |Sysbem Family: Model Lines - |

Type: | - |

27. Select the Roof tool, and
then Roof by Footprint.

Instance Parameters - Control selected or to-be-created instance

Parameter | Value

»

Constraints
28. Check Defines slope. e o o e = E

Dimensions
29. Click on the Properties L e .
button on the Ribbon. Properties

30. Set the roof pitch to 3/12
(Figure 7-1.8); click OK.

FYI: The "Defines slope” option
must be selected to change the

pitch.

31. Set the overhang to 2'-0" and [ o ][ cacal
make sure Defines slope is *
selected, by being checked on Figure 7-1.8 Properties for roof tool

the Options Bar.

-7
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32. Select the East wall.

33. Uncheck Defines slope in the
Options Bar.

34. Select the remaining three walls
(Figure 7-1.9).

35. Pick Finish Roof.

36. Select Yes to attach the walls to the
roof.

FYI: You can also change the pitch of the roof
by changing the Pitch Control text; just select
the text and type a new number (Figure 7-1.9).

s ]
Pitch
Control \
N
A
‘/_/_ 3”
=
2T
Control /
Arrows
zl _ :III
=
]

Figure 7-1.9 Selected walls

TIP:

You can use the Control Arrows, while the roof line is still selected, to flip the
orientation of the roof overhang if you accidentally selected the wrong side of the
wall resulting in the overhang on the inside of the building.

37. Switch to the South elevation view (Figure 7-1.10).

o W |

T.0 Masann_,
o

Le 11
P

Figure 7-1.10 South elevation — Shed roof
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]

38. Switch to the 3D view (Figure 7-1.11).

V%

Figure 7-1.11 Default 3D view - Shed roof

Once the roof is drawn, you can easily change the roof’s overhang. You will
try this on the shed roof. You will also make the roof slope in the opposite
direction.

39. In T.O. Masonry view, Select Modify from the Quick Access Toolbar,
and then select the shed roof.

40. Click Edit Footprint from the Ribbon. A
Edit
41. Click on the East (right) roof sketch-line to FDDtF;rim
select it.

42. Uncheck Defines slope from the Options Bar.

43. Now select the West roof line and check “defines slope.”
If you were to select Finish Roof now, the shed roof would be sloping in the
opposite direction. But, before you do that, you will adjust the roof overhang

at the high side.

44. Click on the East roofline again, to select it.
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45. Change the overhang to 6’-0" in the Options Bar.
Changing the overhang only affects the selected roofline.
46. Select Finish Roof.

47. Switch to the South view to see the change
(Figure 7-1.12). - -—

That concludes the shed roof example. .

Figure 7-1.12 South elevation -
Shed roof (revised)

Flat roof:
48. Switch back to the T.0. Masonry floor plan view.

49. Select the Roof (down-arrow) tool and then Roof by Footprint.

50. Set the overhang to 2’-0"” and make sure Defines slope is
unchecked on the Options Bar.

51. Select all four walls.
52. Pick Finish Roof.

53. Select Yes to attach the walls to the roof.

ﬁiimw?s
o e i ot g
Figure 7-1.13 South elevation - Flat roof

54. Switch to the South elevation view (Figure 7-1.13).
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]

55. Also, take a look at the 3D view (Figure 7-1.14).

1/
S

Figure 7-1.14 Default 3D view - Flat roof

56. Save your project as ex7-1.rvt.

Want more?

Revit has additional tools and techniques available for creating more complex roof
forms. However, that is beyond the scope of this book. If you want to learn more
about roofs, or anything else, take a look at one of the following resources:

e Revit Tutorials from the Help pull-down menu
e Revit Web Site (www.autodesk.com)
¢ Revit Newsgroup (potential answers to specific questions)
(www.augi.com; www.revitcity.com; www.autodesk.com)
e Revit Blogs information from individuals (some work for Autodesk and
some do not) www.revitoped.com, insidethefactory.typepad.com
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Reference Material: Roof Position relative to Wall:

The remaining pages in this exercise are for reference only and do not need
to be done to your model. You are encouraged to study this information so
you become more familiar with how the Roof tool works.

The following examples use a brick and concrete wall example. The image
below shows the Structure properties for said wall type. Notice the only item
within the core boundary section is the Masonry — Concrete Block (i.e., CMU)
which is 758" thick (nominally 8”). Keep this in mind as you read through the
remaining material.

Edit Assembly e
Family: Basic Wall
Type: Exterior - Brick on CMU
Total thickness: 17y Sample Height: | EalN
Layers
EXTERIOR. SIDE

-

Function Material
Finish 1 [4]
Thermal/AirLa  : Misc. Air Layers
Thermal/AirLa  :Insulation / The
Membrane Lay  : Vapor/ Moistur

2
3
4
5 | Core Boundary : Layers Above Wr
6
7
8

Mascnry - Brick

3 H

3

0

i

o
INTERIOR. SIDE

[ Insert ][ Delete ] Up

Default Wrapping
At Inserts: At Ends:

[Do not wrap '] [None ']

Structure [1] Masonry - Con
Core B dary : Layers Below Wr
Substrate [2] Metal - Furring

BESHESTETETEESY

Modify Vertical Structure (Section Preview only)

Modify Merge Regions Sweeps

Assign Layers Split Region Reveals

<< Preview I [ 0K ] [ Cancel ] [ Help

The following examples will show you how to control the position of the roof
system relative to the wall below, both vertically and horizontally. The roof
properties that dictate its position basically involve relationships between
three things: the Level Datum, the exterior Wall System and the bottom
edge of the Roof System. There are several other properties (e.g., pitch,
construction, fascia, etc.) related to the roof that will not be mentioned at the
moment so the reader may focus on a few basic principles.
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The examples on this page show a sloped roof sketched with “Extend into
wall (to core)” enabled and the Overhang set to 2’-0”. Because “Extend into
wall (to core)” was selected, the bottom edge of the roof is positioned
relative to the Core Boundary of the exterior wall rather than the finished
face of the wall. See the discussion about the wall’s Core Boundary on the

previous page.

_ Level 2

<5
S
>

o
R
SR

e
oo
8
K558

hote!
%

00
R A

<0

0

<5
%5

5%

5
N
LRREERLS

NN

R
oo
%%

%
¥

Extend to Core + Rafter

107- 0"

Ref
Point

_Level 2

10- 0"

Ref
Point

I R R N

Wall
Core

Extend to Core + Truss

Revit Roof Properties under consideration:

Extend into Wall: This option was checked on the Options Bar while

(to core) sketching the roof.

Rafter or Truss: This option is an Instance Parameter of the roof object;
the example on the left (above) is set to Rafter and the
other is set to Truss. NOTE: The “"Extend into Wall (to core)”
option affects the relative relationship between the wall and the
roof, as you will see by comparing this example with the one on

the next page.

Base Level: Set to Level 2. By associating various objects to a level,
it is possible to adjust the floor elevation (i.e., Level
Datum) and have doors, windows, floors, furniture, roofs,
etc., all move vertically with that level.

Base offset: Set to 0’-0”. This can be a positive or negative number
from level which will be maintained even if the level moves.
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The examples on this page show a sloped roof sketched with “Extend into
wall (to core)” NOT enabled and the Overhang set to 2’-0”. Notice that the
roof overhang is derived from the exterior face of the wall (compared to the
Core Boundary face on the previous example when “Extend into wall” is

enabled).

_ Level 2

10'- 0"

Ref

Point _ Level 2

% . 10'- 0"

Ref
Point

] 72 I '

T T T T A T

O I B AN

Wall
Wall Core
Core H‘

Rafter + not extended to core Truss + not extended to core

Revit Roof Properties under consideration:

Extend into wall: This option was NOT checked on the Options Bar while

(to core)

Rafter or Truss:

Base Level:

Base offset:
from level

sketching the roof.

This option is an Instant Parameter of the roof object; the
example on the left (above) is set to Rafter and the other
is set to Truss. NOTE: The "Extend into wall (to core)” option
affects the relative relationship between the wall and the roof,
as you will see by comparing this example with the one on the
previous page.

Set to Level 2. By associating various objects to a level,
it is possible to adjust the floor elevation (i.e., Level
Datum) and have doors, windows, floors, furniture, roofs,
etc., all move vertically with that level.

Set to 0-0”. This can be a positive or negative number
which will be maintained even if the level moves.
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Modify Roofs > Edit Footprint Cwverhang: 2' 0" || Defi Extend into wall (to core)
Projectl - Project browser £ ‘
| =0 Views (all)

As you can see from the previous examples, you would most often want to
have “Extend to wall (to core)” selected while sketching a roof because it
would not typically make sense to position the roof based on the outside face
of brick or the inside face of gypsum board, for commercial construction.

Even though you may prefer to have

“Extend to wall (to core)” selected, i |
you might like to have a 2'-0” i e o
overhang relative to the face of the ot thickness: 1 71/2° Sampleteht: | FO
brick rather than the exterior face of
concrete block. This can be EXTERIOR SIDE
accomplished in one of two ways: Fi,-.is T——
a. You can modify the overhang, Trormal R T osuiiion, Yo
while sketching the roof, to e e
include the wall thickness that o By mo &
occurs between the face of & Substiote B Metal - Furing 0" 1 5/8" i
wall and face of core: 2'-0” + ST s
958" = 2'-95%" (See the image (ot [sbeeinns] [
to the rlght) 2:?;::[\:Taming At Ends:

[Do not wrap v] [None v]

b. The second option is to
manually edit the sketch lines.
You can add dimensions while
in Sketch mode, select the
sketch line to move, and then <cpreven | [ ok ][ caxd ][ neo

Modify Vertical Structure (Section Preview only)

Modify Merge Regions Sweeps

Assign Layers Split Region Reveals

edit the dimension. The
dimension can also be locked
to maintain the roof edge
position relative to the wall.
When you finish the sketch
the dimensions are hidden.

Energy Truss:

In addition to controlling the roof overhang, you might also want to control
the roof properties to accommodate an energy truss, with what is called an
energy heal, that allows for more insulation to occur directly above the
exterior wall.

To do this you would use the “Extend into wall (to core) + Truss” option

described above and then set the Base Offset from Level to 1’-0”, for a 1’-0”
energy heal. See the image and the dialog box shown on the next page.
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SO
Q
2%

NN NN

SLRXR

ooecesece:
SR

<

e

%7

NV
KKK

<

,v
QR

A
S

”
7 Instance Properties \

Many other properties and
techniques exist which one can use
to develop the roof for a project.
Things like the Rafter Cut and Fascia

Family:  [System Famiy: Basic Roof -] Load... \

Type:  [Generic-12° * [ Edttype.. |

Instance Parameters - Control selected or to-be-created instance

| Parameter | Value ‘ = . .

| Depth control the fascia design. Also,
e you can apply a sweep to a roof edge
. to add a 1x fascia board around the
Cucirlend building. These are intermediate to

! advanced concepts and will not be
s st covered here.
Rafter or Truss Truss
Maxirmum Ridge Height 19" 9" .

| This concludes the study of the Roof

iII:F:Eness i 212 tOOI I
Volume 1316.65 CF
Area 1316.65 SF
|MentiyData &
Comments
Mark
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Law Office Roof

The template file you started with already has a Roof plan view created.
However, you renamed that to Level 2 and then created a new Roof datum
and corresponding views. If you recall, the Roof datum is at 26’-8"” (see page
6-34). This Roof plan view creates a working plane for the Roof tool; the
thickness of your roof sits on top of the Reference plane.

Create a Gable Roof:
1. Open your Law Office BIM file.

2. Switch to the Roof plan view.

Your image should look something like Figure 7-2.1. The exterior walls you
can see in the Roof plan view were created in Lesson 6; the specified height
extends into the Roof’s View Range. The interior walls and stairs are visible,
but are shaded gray (i.e., halftone); this is because of a view setting called
Underlay. The Underlay feature is used to visually coordinate items between
floors. In the roof plan you might want to know where the wall between the
two toilet rooms is to discern where the vent pipe will penetrate the roof.

You will be selecting the exterior walls to define the edge of the roof. Before
you can finish a roof sketch, you must have the entire perimeter of the roof
drawn with line endpoints connected. Revit allows you to sketch additional
lines and use tools like Trim to complete the perimeter of the roof sketch if
needed.

3. Select the Roof tool from the Home tab.

4. Select Roof by Footprint from the pop-up menu.

5. Make sure Pick Walls is selected Ribbon: Home - Draw (panel).

== : Autodesk Revit Architecture 20

Home Insert Annotate Modify Massing &Site  Collaborate  View  Mang

b REmmw 2020 [N =

Modify @ Slope Arrow

Properties | Align Measure Dime

S D J{ R Eaves T M

Selecti... Draw Tools Inquiry Anng
Create Roof Footprint [] Defines slope Cv®hang: 0' Q" Extend to wall core

Law Office.rvt - Project browser

B 1
J.B o, Views (all) - ‘ ‘
e pare | ) PR P L

iny
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L
[T
Figure 7-2.1 Roof Plan; initial view
B " Instance Properties g
6- UnCheCk Defines Slope on Family: [SyshemFamin:ModelLines '] Load...
the Options Bar, to make a = sl e
fl at rOOf' Instance Parameters - Control selected or to-be-reated instance
Parameter | Value |
7. Click the Properties button Constraints A
on the Ribbon. T f
Dimensions H
These are the properties for the woes - :
sketch lines, not the roof element ,
(cf. Roof Properties)
8. Notice, if this were a sloped
roof, you could change the
roof pitch here.
9. Without making any
changes, click OK.
10. Check Extend to wall core I =

on the Options Bar.
Figure 7-2.2 Roof Properties
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We will digress for a moment to explain exactly what “extend to wall core”
means. This will help ensure you create the roof correctly. First the
properties of the wall will be exposed so you understand what constitutes a
wall type core. Next, you will learn how this ties into the roof tool. If you
want to follow along, you can select Cancel Roof on the Ribbon and then
repeat the previous steps before moving on to the next numbered steps.

Back on page 6-18 and following you explored the exterior wall style. There
it pointed out where to view/edit the “structure” of the wall Layers, via the
Edit Assembly dialog. The graphic below shows a variety of wall types with
their wall cores highlighted. Within the Edit Assembly dialog, the highlighted
Layer(s) fall within the Core Boundary section.

Generally speaking, the Wall Core represents the real-world structural
portion of the wall. Walls can be both drawn and dimensioned based on the
faces and centerline of the wall core. The Wall Core has a higher precedence
when walls intersect. Revit automatically cleans up similar Layers within
other wall types. Additionally, in the case of this exercise, the wall core is
used in conjunction with creating the roof element. This is also true for floors
as well.

Stud wall Stud furring Masonry cavity wall CMU wall

Notice a few things about the walls above before moving on. The two walls
on the left have the metal stud Layer within the Wall Core, but the masonry
cavity wall does not. In the first two, the studs are the structural element
holding up the wall, in the latter the CMU holds up the wall and the metal
studs are just used to fasten the gypsum board to it. Finally, the fourth wall
contains one Layer which is the Wall Core. Every wall must have at least one
Layer within the Core Boundary. An example of two Layers within the Core
Boundary might be the studs and the sheathing which is used for shear;
making both Layers part of the structural makeup of the wall. In this case
you would never want any intersecting wall to interrupt the sheathing.

When using the Roof tool, it is possible to have Revit automatically sketch
the roof’s edge based on one of the two faces of a Wall Core. Therefore, it is
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important to select towards the side of the wall relating to the core face you
want. The two images below show the two options possible when Extend wall
to core is selected within the Roof tool.

wall wall
core boundary core boundary

I | | |
T e— e
a T el 3

Roof et Roof
26'-8" 20

Roof tool: Extend to core options

Notice in both images above, the gypsum board Layer within the wall type is
interrupted by the roof. You will employ the option on the left. However,
either option is perfectly valid depending on how the building is intended to
be constructed: a separate parapet or balloon framing.

In either case, due to the use of metal studs, the roof deck will be supported
by steel beams at the perimeter. The structural system will be added in the
next chapter. Revit does not care if a roof or floor is not properly supported,
which is not the case with beams, as you will see in the upcoming structural
section.

11. Select each of the exterior walls, favoring the exterior side when
clicking the wall. Just before clicking, the dashed reference line
should be at the exterior face of the wall core per the example shown
in Figure 7-2.3.

TIP: Use the Flip control icon while the line is still selected if your dashed
reference line is on the wrong side (i.e., interior).
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4 Correct

, Not correct

Figure 7-2.3 Roof Plan; four walls selected for sketching roof footprint

Note that the exterior walls, just selected, can be selected in any order.

All of the sketch lines should have automatically trimmed at the corners
(Figure 7-2.4). If not, you would need to use the Trim tool to close the

perimeter of the roof footprint. Many of your 2D drafting skills learned earlier
in this book can be applied to this type of Sketch mode.

Figure 7-2.4
Roof sketch lines at perimeter of building
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Before completing the roof you will learn how to specify the Roof _
-

Type. This is similar to walls in that various Layers can be defined =
within the roof element. Roof
Properties
12. Select Roof Properties on the Ribbon. Elemant
( i ' Instance Properties ﬁ
Family: [SystemFamin: Basic Roof '] Load... N0t|Ce |n F|gure 7'2.5 that the
Type:  [Insulation on Meial Dedk- EPDM g [ edrvee | Type drop-down at the top

Generic - 3"

Instance Par Generic - 127
Generic - 12" - Filled

lists five roof types.

Generic - 18"

Insulation on Metal Dedk - EPDM
Constraints

P As already mentioned, the

3

Base Level Roof overall roof thickness sits on
zoom Jouneng top of the Level datum of the
Base Offset From Level oo VleW |n WhICh |t was draWn.
i) Hone Typically, the Roof Level
o i | datum relates to the top of
Rafter Cut Plumb Cut ) the steel beams. Thus the roof
Fascia Depth [ .

Rt o oo occurs above that elevation.

Maximum Ridge Height [

Dli'r'm A Notice the parameter Base
- eI Offset From Level. This allows
Volume i you to enter a distance in
— : which to move the roof up
Comments from the Base Level. If you
Merk - entered 2’-0” and the roof
level datum changed, the roof
Lo JL e JIE  \ould still be 2'-0” above the

repositioned level datum.
Figure 7-2.5 Roof properties; selecting roof type

13. Make sure the Type is set to

Insulation on Metal Deck - EPDM. Q? X
Finish  Cancel
Now that the roof footprint is complete you can finish the Roof  Roof
roof. Roof
14. Select Finish Roof (- =%

from the Ribbon.

Would you like to attach the highlighted walls to
15. Click No to attach the roof?
walls (Figure 7-2.6).

Figure 7-2.6 Roof Plan; attachment warning
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16. Click Yes to join the roof and exterior walls.

Revit

Joining the roof and walls via
this prompt is what interrupts
the stud Layer as shown in the
graphic on Page 7-20.

The floor/roof overlaps the highlighted wall(s).
Would you like to join geometry and cut the
overlapping volume out of the wall(s)?

Figure 7-2.7 Roof Plan; join and cut prompt

17. Switch to your 3D view via the Quick Access Toolbar.

Your project should look like Figure 7-2.8.

Figure 7-2.8 3D View; roof added
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[ i3 instance Properties (i) 18. Switch back to your
Roof floor plan view.

Family: [Sysbem Family: Floor Flan V] Load...

Twe (il 2 (i Despite the fact that you just

Instance Parameters - Control selected or to-be-created instance added a rOOfI Whlch |S a Solld
Parameter Value |~ 3D element, you can still see

Graphics & the second floor walls. When

View Scale 14 =1-0" . .

Scale Value 1: 48 the Underlay feature IS Set, |t

Display Model Normel will show the selected level on

Dretail Level Coarse . . . .

Visibility/Graphics Overrides [ Edit... = top Of Whatever IS VISIbIe in the

Model Graphics Style Hidden Line current view. At this p0|nt we

Graphic Display Opti

ey TR o —— don’t want to see the Level 2

Underlay Orientation Plan Wa”s anymore.

Orientation Project Morth

Wall Join Display Clean all wall joins 3

Discipline Architectural 19. Right-click within the

Color Scheme Location Background . =

Color Scheme [ <nonex VIEW and_ select View

Identity Data N Properties from the

View Marme Roof -

Dependency Independent pOp UD menu.

Title on Sheet

Referencing Sheet Ad

Referencing Detail 1 <

20. Set the Underlay
[ o J[ cona | Parameter to None
(Figure 7-2.9).

Figure 7-2.9 Roof plan view; view propertied

21. Click OK twice to close the open dialog boxes.
The Level 2 walls are now removed from the Roof plan view.

At some point in the project you would edit the roof surface to have the
required sloped surfaces to shed rain water towards the roof drains. But
those types of edits are best saved for later in the design process. If you
spent the time to model that information now and then the client decided to
make a big change, you would have to redo all that work.

22. Save your project.

TIP: You have probably figured this out by now: the last view open when
you close the project will be the view that is opened the next time the
project is opened.

7-24



Law Office: ROOF, FLOORS & CEILINGS

Floor Systems

In this exercise you will add the Level 1 and Level 2 floors. The Level 1 floor
is a slab-on-grade example, as the building has no basement, and Level 2 is
a composite concrete and metal deck floor. Both of these walls are already
defined in the project, which stems from the template from which it was
started.

Level 1, Slab on Grade:
Sketching floors is a lot like sketching roofs; you can select walls to define
the perimeter and draw lines to fill in the blanks and add holes, or cut outs,
in the floor object.

1. Open your Revit project (Law Office).

2. Switch to the Level 1 floor plan view if needed.

3. Select Home - Build > Floor (down-arrow) - Floor. [=JFloor -

4. Click the Floor Properties button on the Ribbon. G;_
( B ' Instance Properties ﬁ1 Floor
Properties
Family: [Syshem Family: Floor '] Load...
Type: 4" Concrete Slab v] [ Edit Type... ] 5' Set the Type to
_ 4" Concrete Slab
Instance Parameters - Control selected oMto-be-created instance . .
E— | — B (if not already); see Figure

o ~ 7-3.1.
Level Level 1
Height Offset From Level oo .
e Bourding 6. Click OK to accept the
Related to Mass Change-
Structural R
Structural |:| . .
Dimensions E Notice the Height Offset From
2P Level, which allows the slab to be
moved up or down relative to the
s S Level that hosts the slab.
Identity Data _ |
Commen U Also, the Phase Created allows you
Phasing to manage which portion of the
E:mgfﬁtjﬁ’h y EMH building is existing and new. The
TS il law office project is all new, so

you do not have to worry about

s i any Phase settings.

Figure 7-3.1 Floor tool; floor properties
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Similar to the Roof Sketch mode, you will be drawing the Boundary Line for
the floor by picking walls. Ultimately your slab will stop at the foundation
walls, but they have not been drawn yet so you will draw the slab to the
interior face of core. Remember, for the roof you went to the exterior face of
core.

7. Make sure the Ribbon and Options Bar match the settings
shown in Figure 7-3.2.
a. Boundary Line selected (Draw panel)
b. Pick Walls icon selected (Draw panel)

c. Extend into wall (to core) checked (Options Bar)

= : e - —,

Home Insert Annotate Moedify Massing & Site

b K 2250 [\
Modify @ Slope Arrow f‘ {‘ P l"d d&f v Properties
@ >4l -
Selection Draw
Create Floor Boundary | Offset: 0" 0" Extend into wall (to care}l}
Law Office.rvt - Project browser B }
IB..;._[:‘*‘\{I__EWS [all}) - = _ -

Figure 7-3.2 Floor tool; ribbon and options bar settings

8. Select the interior side of each exterior wall, with the exception of the
curtain wall (do not select it yet). See Figure 7-3.3.

Figure 7-3.3
Floor tool; boundary lines sketched
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You will select the curtain wall in a moment. However, it is a different
thickness and does not have a core like the other walls. So, when you pick
the wall, the floor boundary sketch line will be centered on the curtain wall.
You will have to manually sketch lines and trim them at each end of the
curtain wall in order to properly enclose the floor boundary.

9. Select the curtain wall, which in turn adds a curved boundary line.

10. Zoom in to each end of the curtain wall, and select .
the Line icon from the Draw panel on the Create D @ t’f O -
Floor Boundary tab. VSR B
S DMK -
11. Sketch a line, using snaps, from the end of the arc
to the adjacent wall sketch line (Figure 7-3.4).

12. Use the Trim tool, while still in the Floor Sketch mode, to clean up
any corners that are not perfect. This is likely only going to be at the
transition from the curved wall to the orthogonal walls.

Figure 7-3.4
Floor tool; boundary lines sketched
at curved curtain wall area

Now that you have the perimeter of the floor defined, you may finish the
creation of the floor element. @

Finish
Floor

13. Click Finish Floor on the Ribbon.

TIP: If you get any errors, see the next page.
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Common errors finishing a floor sketch:

If you get an error message when trying to finish a floor sketch, it is
probably due to a problem with the sketched perimeter lines. Here are
two common problems:

Perimeter not closed:
You cannot finish a floor if there is a gap, large or small, in the
perimeter sketch. Fix: Sketch a line to close the loop.

lﬁ‘ o Sketch lines —
@ e S T a perimeter not
_ ’ closed because
line is missing

y
Autodesk Revit Architecture 2010

Error - cannot be ignored
Lines must be in dosed loops. The highlighted lines are open on one end.

Quit sketching Continue

Error message after clicking finish sketch

Perimeter lines intersect:
You cannot finish a floor if any of the sketch lines intersect.
Fix: Use Trim to make it so all line endpoints touch.

Sketch lines —
lines extend past
each other, not
good

Autodesk Revit Architecture 2010

Error - cannot be ignored
Lines cannot intersect each other. The highlighted lines currently intersect.

s

Error message after clicking finish sketch

7-28



Law Office: ROOF, FLOORS & CEILINGS

The floor for Level 1 has now been created. However, because it has no
surface pattern assigned to it, you cannot really see it. The only place it is
visible is at the two exterior door openings (Figure 7-3.5); this is the best
place to select the slab by pressing Tab to get past the door and select the
slab.

[rononenornnanenan

P

e

/|

!

Figure 7-3.5 Level 1 floor plan; floor slab visible at exterior door openings

Often a surface pattern is not assigned to the structural slab. Instead,
another floor is added in each room to define floor finishes later during the
design process once the plan is fixed. A ¥s8” thick Floor can be created for
each floor finish. The %" Floor is then added to each room, offset 5" from
the host level so it is on top of the structural slab. This method allows various
surface patterns to be applied. If a surface pattern were added to the
structural slab, it would be visible everywhere, such as toilet rooms, the
lobby, and the mechanical room. The other benefit is the ability to schedule
the floor finishes and get quantities. You can even add formulas to the
schedules and get total cost for each flooring type!

Level 2, Slab on Grade:

Creating the second and third floors will be a little more involved than the
first floor. This is because the upper floors require several openings. For
example, you need to define the openings for the stair shaft and the two-
story lobby space. However, Revit makes the process very simple.

You will again use a predefined floor type for the Level 2 floor. The floor you
will use is 52" thick: a 12" metal deck and the remaining is concrete. At this
early stage in the project it may be helpful to modify the floor to have a
Layer that represents a placeholder for the structural joists that hold up the
floor. In section view, this can help better visualize the required space,
before the structural engineers add their elements to the BIM.
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14. Switch to the Level 2 floor plan view.

15.

16.

17.

18.

Click Floor Properties.
Set the Type to LW Concrete on Metal Deck.
Click Edit Type... (at the upper right).

Click Edit, next to the Structure parameter.

You are now in the Edit Assembly dialog; here you will temporarily add a

Layer to serve as a placeholder for the bar joists (Figure 7-3.6). This process
is identical for editing Revit walls and roofs!

Edit Assembly =5

Family: Floor
Type: LW Concrete on Metal Deck
Total thickness: Q' 5 1/2° (Default)

Layers

Function Material Thickness | Wraps | Variable| =
1 | Core Boundary: Layers Above 0" 0" L4
2 | Structure [1] Concrete - C o 4" [l
3 | Structure [1] Metal - Deck :0' 11/2" =
4 | Core Boundary: Layers Below : 0" 0°

Delete Up Down
= i
View: ’Secﬁon: Modify type v] ’ Preview > ] [ OK l ’ Cancel ] ’ Help

Figure 7-3.6 Edit assembly dialog for current floor type.

19. Click the Insert button.

The new Layer should have been placed below the bottom Core Boundary
placeholder. This is fine for what we are attempting to do. You will also set
the Function to “finish” so the walls are not adversely affected by this
temporary element in the floor type.
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|
20. Change the new Layer as follows:
a. Function: Finish 2 [5]
b. Material: <By Category>
C. Thickness: 1'-2"

See Figure 7-3.7.

Function Material Thickness | Wraps| Variable| =
1 | Core Boundary Layers Above 0° 0 L4
2 | Structure [1] Concrete - C 04" =l
3 | Structure [1] Metal - Deck 0" 11/2" =l
4 | Core Boundary: Layers Below 0" 0"
5 | Finish 2 [5] <By Categor (1" 2" [

Figure 7-3.7 Floor properties: layer settings

21. Close the open dialog boxes (i.e., click OK three times).
You are now ready to start sketching the boundary of the Level 2 floor.

22. Using the Pick Wall icon, select the walls shown in Figure 7-3.8:
a. Make sure Extend into wall (to core) is selected.

b. Click to the exterior side of the exterior walls, opposite to what
you did for Level 1.

a4
3
2
A
1
L
5
@W
8
7
Figure 7-3.8
Level 2: Eight floor boundary lines sketched 6
L i
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|
23. Zoom into the North stair, and make the edits shown in Figure 7-3.9.

a. Use the Line and Trim tools from the Ribbon. Remember, these
are the tools and techniques you mastered in Chapter 5.

b. The 8'-4" line should align with the top riser, in the North-South
direction.

DN

Figure 7-3.9
g Level 2: Floor boundary
# at North stair

24. While still in Sketch mode for the Level 2 floor, pan to the right to
show the area in Figure 7-3.10.

You will now define a hole in the floor for ductwork. On a real project, this
may be added later in the project once the mechanical engineer gets

involved and suggests the size of supply and return air ducts needed. You
will add the hole now regardless.

25. Select the Pick Walls icon and with Extend into wall (to core)
checked, select the shaft side of the four walls.

a. Use the flip-control arrows for each sketch line if needed
because the wrong side of the wall may have been selected.

b. Use Trim to clean up the corners.
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]

N e

Figure 7-3.10 Level 2 (North-East corner): Floor boundary at shaft

Whenever a perimeter is drawn within another, it defines a hole.

Next you will define the floor boundary at the two-story lobby, which starts
on Level 1.
26. Sketch the floor opening as shown in Figure 7-3.11:
a. Use the Split tool on the sketch line along the exterior wall.

b. Use the Line tool to sketch the floor opening per the dimensions
shown.

c. Use Trim as needed to clean up the corners.

d. You do not have to add the dimensions, but you can if desired.
They will be hidden when the floor is finished.

The last area to define is the curved edge at the curtain wall. On Level 1 the
floor went under the curtain wall; on Level 2 the floor edge needs to be held
back from the curtain wall, allowing room for it to pass by.

27. Using a similar technique as Level 1, sketch the Level 2 floor edge as
shown in Figure 7-3.12.

a. The curved line is 5” in (towards the interior of the building) in
relation to the adjacent sketch lines.
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31-0"

14'- 10"

11"

- :i\ ]! T T IT IT T}
I 1

Figure 7-3.11 Level 2 (South-East corner): Floor boundary at lobby

Figure 7-3.12 Level 2 (South-West corner): Floor boundary at curtain wall
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You are now ready to finish the floor sketch and let Revit create the 3D floor
object in the BIM.

28. Click Finish Floor on the Ribbon.

29. Click Yes to extending the floor below up to the new floor.

[ Revit 5

Would you like walls that go up to this floor's
level to attach to its bottom?

30. Click Yes to join and cut walls.

[ Revit =5

The floor/roof overlaps the highlighted wall(s).
Would you like to join geometry and cut the
overlapping volume out of the wall(s)?

31. Select the lobby stair
and use the Move tool
to reposition it as
shown in Figure
7-3.13.

Figure 7-3.13 L
Level 2 (lobby area): repositioned stair
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Notice, unlike the Level 1 slab, the LW Concrete on Metal Deck has a surface
pattern defined, which shows up everywhere. You will leave this for now as it
helps to see the extents of the floor in this early design phase of the project.

32. Switch to the Default 3D view.

33. Use the ViewCube to move around the exterior of your building.

Notice you can see the Level 1 and Level 2 floors through the curtain wall

glazing!

Figure 7-3.14 default 3D view: floors visible through glazing

Figure 7-3.15 Level 2 floor

34. Save your project.
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Exercise 7-4:
Ceiling Systems

This lesson will explore Revit’s tools for modeling ceilings. This will include
drawing different types of ceiling systems.

Suspended Acoustical Ceiling Tile System:
1. Open your Law Office project.

2. Switch to the Level 1 ceiling plan view, from the Project Browser;
ceiling plans are just below the floor plans.

Notice the doors” and windows’ visibility are automatically turned off in the
ceiling plan views (Figure 7-4.2). Actually, the ceiling plan views have a
cutting plane similar to floor plans,

except they look up rather than down. (v renge ~x~)
You can see this setting by right- prmary Range
clicking on a view name in the Project Top: Roof < ofet 0o
Browser and selecting Properties, then Cutplane: [ Associted Level (Second F offet: 7 &
selecting View Range. The default Eottom: Acsonated Level (Second P offeet: [7 6
value is 7’-6”. You might increase this —
if, for example, you had 10°-0’ ceilings Level Offset: 0 0"
and 8’-0” high doors. Otherwise, the O e ]
doors would show because the 7’-6" - .
cutting plane would be below the door
heig ht (Figure 7-4. 1)_ Figure 7-4.1 Properties: View Range settings
]
I
I
|
] I
. I
Figure 7-4.2

Level 1 ceiling plan
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3. Close the open dialog boxes and then select @ Ceiling

Home - Build > Ceiling.

You have four ceiling types, by default, to select from (Figure 7-4.3).

-
=

- 3 Autodesk Revit Architectuf

=

Home Insert Annotate Modify Massing & Site  Collaborate Vi

ke =
" i Compound Ceiling o ‘} i
Modify Element 2'x 2" ACT System Auto | Sketi
N Ceiling | Ceili j

Properties
Selection Basic Ceiling Ceiling
Place Ceiling Generic b
Law Office.rvt - Project b “

Compound Ceiling

=0, Views (all)

=} Floor Plans 2" x 2" ACT System h il
B.C. Footing 0\g
- Foundation 2" x 4" ACT System I
e Ll 1 ]
colevel2 58 GWB on M, Stud
o RoOf
- Site Plan Most Recently Used Types 1

- T.0. Footing| Compound Ceiling : 2’ x 2' ACT System
= Ceiling Plans
o Lewel 1
Roof

“M Figure 7-4.3
| 30V VO || IS ot SISV Ceiling: Ribbon options

4. Select Compound Ceiling: 2'x2" ACT System.

Next you will change the ceiling height. The
default setting is 10-0” above the current
level. You will change the ceiling height to
8’-0", this will give plenty of space above
the ceiling to the bottom of the joists,
perhaps for recessed light fixtures and
ductwork. This setting can be changed on a
room by room basis. Hence, it is an instance
parameter.

5. Click the Element Properties >
Instance Properties button.

6. Set the Height Offset From Level
setting to 8'-0" (Figure 7-4.4).

You are now ready to place ceiling grids. This
process cannot get much easier, especially
compared to other CAD programs.

# | Instance Properties ﬁ
Family: [Syshem Family: Compound Ceiling V] Load...
Type: [2 %2 AcT system =] [ EditType..

Instance Parameters - Control selected or to-be-created instance

Parameter | Value

Constraints

13

Level Level 1
Height Offset From Level g 0"
Room Beunding

Dimensions

Slope

3

Perimeter

Area

Volume 0.00 CF

Identity Data

Comments

Mark

Figure 7-4.4 Ceiling: Properties

7. Move your cursor anywhere within the office in the North-West corner
of the building. You should see the perimeter of the room highlighted.

8. Pick within that Northwest room; Revit places a grid in the room

(Figure 7-4.5).

7-38

|t et AP S Bt e, A gt s e M




Law Office: ROOF, FLOORS & CEILINGS

L| L

_— 2'x2" ACT added

=

Figure 7-4.5: Level 1 Ceiling Plan view: 2’x2’ suspended acoustical ceiling tile added to office

You now have a 2’x2’ ceiling grid at 8’-0” above the floor, Level 1 in this
case. Later in the book, when you get to the exercise on cutting sections, you
will see the ceiling with the proper height and thickness.

The image to the left is a camera
view of the room you just added the
ceiling to. You will learn how to
create camera views in Chapter 14.

Next you will add the same ceiling
system to several other Level 1
rooms.

9. Use the Ceiling tool to place 2'x 2" acoustic ceiling tile (ACT) at 8’-0"
above finished floor (AFF) in the rooms shown (Figure 7-4.6).
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[

Figure 7-4.6: Level 1 Ceiling Plan view: 2’x2’ suspended acoustical ceiling tile added to rooms.

When you place a ceiling grid, Revit centers the grid in the room. The general
rule of thumb is you should try to avoid reducing the tile size by more than
half of a tile. You can see in Figure 7-4.6 that the East and West sides are
small slivers for the center office on the South exterior wall. You will adjust

this next.

10. Select Modify from the Quick
Access Toolbar.

11. Select the ceiling grid identified in
Figure 7-4.6. Only one line will be
highlighted.

12. Use the Move tool to move the grid
12" to the East (Figure 7-4.7).

Moving the grid does not move the ceiling
element itself; only its surface pattern.

Next, you will look at drawing gypsum

board ceiling systems. The process is
identical to placing the grid system.
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Gypsum Board Ceiling System:

You will create a new ceiling type for a gypsum board (Gyp. Bd.) ceiling. To
better identify the areas that have a Gyp. Bd. ceiling, you will set the ceiling
surface to have a stipple pattern. This will provide a nice graphical
representation for the Gyp. Bd. ceiling areas. The ceiling you are about to
create would lean more towards a commercial application. You will add this
ceiling to toilet rooms; as it holds up better in locations with moisture and
provides better security. The space above a Gyp. Bd. ceiling is not easily
accessible as acoustical ceiling tile (ACT) is, so access panels are often
required to access shutoff valves, VAV's, etc.

The first thing you will do is look at the Revit Materials which are assigned to
elements throughout the model. Materials are used to manage the pattern
applied to the surface of an element seen in elevation, and the pattern
applied when an element is cut in section. Additionally, a color can be
selected for Shaded with Edges (Model Graphics Style). Later in the book,
you will also learn how a rendering material can be added, which is used
when creating a photorealistic rendering.

Several elements can reference the same material. For example, a door,
trim, a custom ceiling, furniture, etc., could refer to the same wood material,
which could be set to clear maple. If, at any point in the project, the Material
for wood is changed to stained oak, all elements which reference it are
updated. Thus, if several wood finishes or species are required, you would
have to create multiple Materials in Revit.

13. Select Manage > Project Settings > Materials. This @
is the list of materials you select from when assigning a _
material to each layer in a wall system, etc. e

14. Select Gypsum Wall Board in the Name list and then click the
Duplicate button and enter the name: Gypsum Ceiling Board
(see Figure 7-4.8).

15. In the Surface Pattern area, pick the button and select Gypsum-
Plaster from the list, and then click OK twice (Figure 7-4.8).

The Surface Pattern setting is what will add the stipple pattern to the Gyp.
Bd. ceiling areas. With this set to none, the ceiling has no pattern, like the
basic ceiling type. Creating a new material allows you to separately control
the surface pattern of Gyp. Bd. walls vs. ceilings. Walls do not have a surface
pattern typically, whereas ceilings do.

Thus, if you wanted Carpet 1 finish to never have the stipple hatch pattern,

you could change the surface pattern to none via the Materials dialog and not
have to change each view’s visibility override.
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Materials

Materials

Enter Search Words Q

Door - Frame
Door - Panel

Fabric
Generic

Gypsum Wall Board

GFRC - Glass Fiber Reinforced Cory
GFRG - Glass Fiber Reinforced Gy

Insulation / Thermal Barriers -
Insulation / Thermal Barriers -
Insulation / Thermal Barriers -
Insulation / Thermal Barriers -
Insulation / Thermal Barriers -

EIFS - Exterior Insulation and Finish System

Graphics ‘Randar Appearance I Identity | Phys«a\l

Shading
[] Use Render Appearance for Shading

]

RGB 127-127-127

Click here to select

fansparency: 0% ]

Class pattern

Glass - Frosted =

Glazing - Curtain Wall Glazing

Glazing - Window Glazing Gypsum-Plaster

Batt insulation

EIFS - Exterior Insulatio...
Reflective heat barrier
Rigid insulation

Semi-igid insulation

Laminate - Ivory, Matte

Duplicate material
button

SEE
co &
Properties< <

00

.

Black

CutPattern

7

Sand Black

OK ] [ Cancel ] [

Apply ]

Figure 7-4.8 Materials dialog

The template you started from does have one Gyp. Bd. Ceiling, but this is
meant for a soffit or a small room where the ceiling is not suspended from
the structure above; it has 35" metal studs. You will use this ceiling as a
starting point, and create a ceiling with 34" metal furring over 12" metal
studs/channels. All of this is then suspended by wires from the structure
above; these wires are not modeled in Revit.

16. From the Modeling tab on the Design Bar,

17.

18.

19.

20.

select Ceiling.

Set the Type to 5/8” GWB on Metal Stud.

= Ceiling

Click the Element Properties button (Figure 7-4.3).

FYI: You are selecting this because it is most similar to the
ceiling you will be creating. GWB = Gypsum Wall Board

Click the Edit Type button.

Click Duplicate and type the name Susp GB on Metal Stud.

At this point you have a new ceiling type available to be placed in the model.
However, it is exactly like the one you copied (i.e., %" GWB on Metal Stud).
Next, you will modify the composition of your new ceiling type system family.
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21. Select Edit next to the Structure parameter.

22. Create a Layer and set the values as follows (Figure 7-4.9):
a. 112" Mtl. Stud
b. 34" Mtl. Stud
c. Gypsum Ceiling Board
(This is the material you created in Step 13.)

TIP: Use the Insert button to add a new Layer and then, with
the new Layer selected, use the up and down buttons to
reposition the Layer within the ceiling system.

23. Click OK three times Edit Assembly =5
to Close the open Family: Compound Ceiling
dlalog boxes. Type: Susp GB on Metal Stud
Total thickness: o 278"
Layers
Function Material Thickness | Wraps | =
1 | Core Boundar : Layers Above Wrap oo (4
FYI: 2 | Structure [1 Metal - Stud Layer o 112"
The Cei“ng assembly you 3 [Structure [1 | Metal - Stud Layer 0" 03/4"
q 4 | Core Boundar : Layers Below Wrap o0
JUSF created represents a 5 |Finish2[5] | Gypsum Ceiling Board 0’ 0 5/8"
typical suspended Gyp. Bd.
ceiling system. The Metal
Studs are perpendicular to

each other and suspended

q L. J -
by wires, similar to an ACT S P fonn

system.

’ <= Preview ] [ OK ” Cancel ” Help

You are now ready to draw
a gypsum board ceiling.

Figure 7-4.9 New ceiling - edit assembly

24. Make sure Susp GB on Metal Stud is selected in the Element Type
Selector on the Ribbon.

25. Set the ceiling height to 8’-0".

26. Pick the two toilet rooms as shown in Figure 7-4.10.
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([T E—

BACK
STAIR

5

Figure 7-4.10 Gyp. Bd. Ceiling

MECH. ROOM

You now have a gypsum board ceiling at 8’-0” above the Level 1 floor slab.
Notice the stipple pattern does a good job of highlighting the extents of the
Gyp. Bd. Ceiling, as compared to the adjacent mechanical room which will
not have a ceiling.

Design Integration TIP: Once the structure and HVAC (i.e., ductwork) have been
added, any ceilings will obscure those elements if they are lower in elevation.
However, all those elements will show in the mechanical room. Showing the
structure and HVAC is great for coordination and helps the contractor understand the
project better. For instance, how difficult would it be to paint the Mechanical Room
structure and ductwork.

Adding a bulkhead:

Next, you will place a ceiling in the hallway. However, you cannot simply pick
the room to place the ceiling because Revit would fill in the adjacent lobby
and office area. First, you will need to draw bulkheads to close these areas
off at the ceiling level. They will not be visible in the floor plan view as they
do not pass through its cut plane. A bulkhead is a portion of wall that hangs
from the floor or structure above and creates a closed perimeter for a ceiling
system to abut into. The bulkhead will create a perimeter that the Ceiling
tool will detect for the proper ceiling placement.

27. While still in the Level 1 ceiling plan view, select the Wall tool.

7-44



Law Office: ROOF, FLOORS & CEILINGS
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Figure 7-4.11 Bulkhead (wall) properties

30.

[ 1 ' Instance Properties ﬂ 28 C“Ck Ins_tance
Properties from the
Family: [System Family: Basic Wall - ] Load... Rlbbon
Type: [interior - 4 7/8" Partition (1-+r) ») [ EdtType.. |
Instance Parameters - Control selected or to-be-created instance 29' Set the Wa” type to'
Parameter Value |: Interlor = 4 7/8"
Constraints % Partition (1-hr) and the

Base Offset to 7'-10".
This will put the bottom of
the wall to 7-10” above the
current floor level, Level 1 in
this case (Figure 7-4.12).

Set the Top Constraint to:
Up to level: Level 2
(Figure 7-4.11).

TIP: The next time you
draw a wall, you will have to
change the Base Offset back
to 0-0” or your wall will be
7’-10" off the floor; this is
hard to remember!

31. Draw the bulkhead;
make sure you snap to
the adjacent walls
(Figure 7-4.12).

Figure 7-4.12 Bulkhead modeled
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32. Select the Ceiling tool and hover your cursor over the hallway.

Notice, in Figure 7-4.13, how the bulkheads create a valid perimeter in the
hallway. If the bulkhead bottom was 8’-2" or the ceiling height were 7'-8",
Revit would not find this same perimeter. Take a moment and give it a try.
Undo any changes before moving on.

Figure 7-4.13 Ceiling perimeter highlighted

33. With the ceiling height set to 8'-0", click in the hallway to place the
2'x2’ ACT System.
34. Reposition the grid as shown in Figure 7-4.14.

a. Sometimes, with odd shaped rooms like this, it can be
impossible not to have small slivers of tiles.

Figure 7-4.14 Hallway ceiling placed

Design Integration TIP: In addition to laying out the ceiling tile to minimize sliver
tiles, the grid needs to accommodate the lighting design. In the hallway, a full tile is
provided down the center with this in mind.
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35. Place the remaining bulkheads and 2'x2" ACT ceilings per the image
below; note the ceiling and bulkhead heights vary (Figure 7-4.15).

36. Use the Align tool to make adjacent ceiling grids line up as shown;
remember, select the item you do not want to move first.

‘H\HIHH
N O B
1 @
Ml &

oo
H &

H =
H =
=
v

-0

.

Bulkhead at 9'-0" —
follow floor edge

S o

=

Figure 7-4.15 Remaining Level 1 ceilings and bulkheads

You are now ready to move on to the Level 2
reflected ceiling plan. First, you need to
create a view in which to work.

37. Select View > Create - Plan
Views - Reflected Ceiling Plan.

38. Do the following:
a. Select Level 2.
b. Set the scaleto 1/4"” = 1'-0"

39. Click OK.

Deleting a ceiling grid:

When selecting a ceiling grid,
Revit only selects one line. This
does not allow you to delete the
ceiling grid. To delete: hover
cursor over a ceiling grid line
and press the TAB key until
you see the ceiling perimeter
highlight, then click the mouse.
The entire ceiling will be
selected. Press Delete.

You now have a Level 2 ceiling plan view in which to work. It is possible to
make multiple plan or ceiling views of the same level (e.g., floor plan, finish

plan, code plan, etc.)
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40. Using the techniques previously covered, add the Level 2 ceilings per
the information provided in Figure 7-4.16.

a. Rotated ceiling:
i. Select a grid line.
ii. Use the Rotate tool.
iii. Move the grid as shown.

b. Bulkhead:
i. Bottom at 8'-0"
ii. Draw with Arc tool or Pick with offset.
iii. Show approx. 3'-0" from exterior wall.

Figure 7-4.16 Level 2 ceilings and bulkhead

41. Save your project.
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Self-Exam:
The following questions can be used as a way to check your knowledge of this
lesson. The answers can be found at the bottom of the page.

1. You don't have to click Finish Roof when you are done defining a roof. (T/F)

2. The wall below the roof automatically conforms to the underside of the roof
when you join the walls to the roof. (T/F)

3. The roof overhang setting is available from the Options Bar. (T/F)

4. To create a gable roof on a building with 4 walls, two of the walls should not
have the option checked.

5. Is it possible to change the reference point for a temporary dimension that
is displayed while an object is selected? (Y/N)

Review Questions:
The following questions may be assigned by your instructor as a way to assess your
knowledge of this section. Your instructor has the answers to the review questions.

1. When creating a roof using the “create roof by footprint” option, you need to
create a closed perimeter. (T/F)

2. Can the “defines slope” setting be changed after the roof is “finished”? (T/F)
3. The ceiling grid position cannot be modified. (T/F)
4. To delete a ceiling grid, you must first select the perimeter. (T/F)

5.  While using the Roof tool, you can use the tool from the
Ribbon to fill in the missing segments to close the perimeter.

6. You use the variable to adjust the vertical position of the roof
relative to the current working plane (view).

7. While using the Roof tool, you need to select the tool from
the Quick Access Toolbar before you can select a roofline for modification.

8. You need to use the to flip the roofline when you
pick the wrong side of the wall and the overhang is shown on the inside.

9. A second, internal, perimeter creates a hole in the floor. (T/F)
10. Changing the name of a level tag (in elevation) causes Revit to rename all

the corresponding views (plan, ceiling, etc.) if you answer yes to the
prompt.

Self-Exam answers:
1-F,2-T,3-T,4 - definesslope, 5-Y
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